99

Excel

Lom

Microsoft Office Excel 2013

PivotTables and PivotCharts

99Excel Training Academy

A Microsoft Excel - Vba Training Institute, India




99Excel Training Academy

Microsoft Office Excel 2013
PivotTables & Pivot Charts

Table of Contents

T d o Te [V Lot oo H TSP PP UPROUPRTRON 4
Y 1T 7= O] o T[Tt 4 7SR 4
PIVOTTADIES ...t b e s b b e e s b et e s bt e e s b e e e s e e e e b e e s eab e s enb e e snaee e 5
Creating PIVOTTADIES ... e e e e e e e e st e e e e e e e ee st e e e eeeeesesnssraaaseaeesesannnrtraneaeeans 5
Analyzing Data With PIVOtTables.......c..eeiiiieeeee e e e e e s e s e e e e e e e s e nerareeeeeeeeeannneeens 8
=T T oY =d d o =T e Vo A 1 o ][R 9
1Yo} { O g - o £ PP OO 11
(@1 Lo Y= o Vo @1 o - [ o 3 SRR 11
FIEring the PIVOTCRAIT ... e e e e e e s e e e e e e e e se s asetaeeeeeeesseannstaeneeeaessennnns 14

U Ty I Tol =T Ao T 1 =T o D - USSP 16
Inserting Slicers into your PivotTable or PIVOTChArt.........cooii it e e e e e e e e 16
Ji¥e [o [ A oY F=1 I] [ ol =Y G @ o d o o I3 SURPR 18

7Y [o [ A oY F=1 I o 11 1 TR 19

Excel..

Microsoft Office Excel - VBA Training Academy




Introduction
This booklet is the companion document to the Excel 2013: PivotTables and Pivot Charts workshop.
The booklet will explain PivotTables and Pivot Charts, how to create them, and how to use them to

quickly analyze large quantities of data.

Learning Objectives

After completing the instructions in this booklet, you will be able to:

Understand what PivotTables and Pivot Charts are
Insert PivotTables

Insert Pivot Charts

Filter information in your PivotTable and Pivot Chart
Understand what Slicers are

Insert Slicers

Revised 8/23/2014
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PivotTables

PivotTables are a powerful tool in Excel that will allow you to quickly summarize, sort, filter, and

analyze data. They can handle large amounts of data in lists and tables by organizing data, on the fly,

by different rows and columns. This is faster, and more flexible for analyzing your data, as you don’t

need to rely on formulas.

For example, you could have a spreadsheet that contains information on salespeople, products sold,

regions, items sold, etc. Using a PivotTable, you can quickly organize the data so different relationships

are visible (e.g. Who is the top salesperson? What product has sold the most?) (See Figure 1).

Salesperson Product Region |Customer Date Item Cost | No.ltems | Total Cost
Vaughn, Harlon Captain Recliner NE B&B Spaces 01/03/11| S 340.95 9 |S 3,068.55
Norman, Rita Media Armoire SE Home USA 01/03/11| S 340.95 2|S 681.90
Christensen, Jill Bamboo End Table NW Ellington Designs |01/04/11| $ 79.99 7S 559.93
Norman, Rita Bamboo Coffee Table |SE Ellington Designs |01/05/11| S 168.95 3|S 506.85
Byrd, Asa Bamboo End Table SE B&B Spaces 01/05/11| S 79.99 12 [ § 959.88
Owen, Robert Chameleon Couch SW Ellington Designs [01/07/11| § 799.95 13 | $10,399.35
Maynard, Susan Bamboo End Table NE Home USA 01/08/11| § 79.99 10 | S 799.90
Norman, Rita Chameleon Couch SE Home USA 01/08/11| § 799.95 2 |$ 1,599.90
Norman, Rita Media Armoire SE Home USA 01/08/11| $ 340.95 6 S 2,045.70
Norman, Rita Media Armoire SE B&B Spaces 01/11/11| § 340.95 13 | $ 4,432.35

Figure 1 - Sample Sales Spreadsheet

Note: When working with PivotTables, the data should contain your titles in a single row, and the table

should not contain any empty cells.

Creating PivotTables
The following will show you how to create a PivotTable using the sample sales spreadsheet as an

example:

1. Inthe Ribbon, click on the Insert tab (See Figure 2).

HOME INSERT AGE LAYOUT FORMULAS DATA, REVIEW WIEWY DEVELOPER
) o = sls = = AR
53] X > I ? M- = X I m _a‘g 7 E= 4 0
: ¢ e e WA | R
Tables Illustrations &pps  Recommended PivotChart Power Sparklines Filters Hypetlink Text  Symbols
M v v Charts . RS - Wiew v v v v
Chatts i« Reports Links

Figure 2 - Insert Tab
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2. Under the Tables grouping, click on PivotTables (See Figure 3).

i® E
J| &
PivotTablejRecommended Table

PivotTables
Tables

Figure 3 - PivotTable

3. The Create PivotTable window will appear. Excel will automatically select the data it thinks you
want to use to create your PivotTable (See Figure 4).

=

Create PivotTable

Choose the data that you want to analyze
@ Select a table or range

Table/Range: | Creating!SAS4:5HS913
(") Use an external data source

Connection name:

Choose where you want the PivotTable report to be placed

() Existing Worksheet

Location:

i

Choose whether you want to analyze multiple tables
[] Add this data to the Data Model

[ OK ] l Cancel

Z

Figure 4 - Create PivotTable Window

Note: To select a different range from what Excel has suggested, click on the cell selection box ()
and use the mouse to select a new range.

4. Under Choose where you want the PivotTable report to be placed, select New Worksheet
(See Figure 5).

Choose where you want the PivotTable report to be placed

Location:

=
2.3

Figure 5 - Create PivotTable on a New Worksheet

5. Click on OK.
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6. The PivotTable will be created in a new worksheet (See Figure 6).

E F G H J K L M N A ,
Date Item Cost | No.ltems Total Cost PivotTable Fields T

01/03/11| ¢ 340.95 9]¢ 306855 | | Choose fields to sdd toreports | % ~

01/03/11| $ 340.95 2% 68190 2 Salesperson

01/04/11| ¢ 79.99 7|6 55993 Product

01/05/11| $ 168.95 3|$ 506.85 To build a report, choose (R;?;:ner

01/05/11| ¢  79.99 12 | $ 959.88 fields from the PivotTable Date

01/07/11| $ 799.95 13 | $10,399.35 Field List Ttern Cost

01/08/11| $  79.99 10 | $  799.90 Nolein

01/08/11| § 799.95 2| ¢ 1,599.90 TataliCesk

01/08/11| $ 340.95 6|3 204570 MORE TABLES.

01/11/11| S 340.95 13 | 4,432.35

01/11/11| S 168.95 10 [ $ 1,689.50

01/11/11| S 340.95 41$ 1,363.80

01/12/11 $ 168.95 SEL 3 1,858.45 Drag fields between areas below:

01/12/11| S 340.95 7S 238665 Y FILTERS Il COLUMNS

01/13/11| $ 79.99 11 | $ 879.89

01/13/11| & 799.95 6|5 4,799.70

01/14/11| $ 340.95 14 | § 4,773.30

01/14/11| $ 168.95 10 [ $ 1,689.50 |

01/19/11| S 340.95 4 (S 1,363.80 = ROWS = VALUES

01/20/11| ¢ 79.99 20 [ $ 1,599.80

01/21/11| $ 340.95 8|S 2,727.60

01/23/11| $ 79.99 115 879.89

01/25/11| $ 340.95 13 [ $ 443235

)
®

7 S Defer Layout Update

Figure 6 - PivotTable Added

7. The PivotTable Fields will appear on the right of the screen (See Figure 7).

PivotTable Fields ¥ %

Choose fields to add to report: e~

Salesperson
Product

| Region
Customer
Date
Item Cost
No.ltems
Total Cost

MORE TABLES...

Drag fields between areas below:

Y FILTERS Il COLUMNS

= ROWS > VALUES

Figure 7 - PivotTable Fields
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Analyzing Data with PivotTables

After creating your PivotTable, the PivotTable Fields list will display the data ranges that you selected,
and four areas that will make up your PivotTable (Filters, Columns, Rows, and Values). You can quickly
move fields in and out of these areas to view your data in different ways.

For example, we want to use the PivotTable to analyze the data and determine how many sales a
salesperson has made of each product.

1. Drag-and-drop your fields into the filter, column, rows, and values boxes (See Figure 8).

PivotTable Fields v
Choose fields to add to report: * g

v| Salesperson
v| Product
v| Region
Customer
Date
Item Cost
v| No.ltems
Total Cost

Drag fields between areas below:

FILTERS@ ol COLUMNS

Region > Product hd

ROWS © 3 VALUES @

Salesperson ¥ Sum of No.lte... ¥

Figure 8 - Setting up Fields

A. Filters area fields are shown as top-level report filters above the PivotTable (See Figure 8).
B. Columns area fields are shown as Column Labels at the top of the PivotTable (See Figure 8).
C. Rows area fields are shown as Row Labels on the left side of the PivotTable (See Figure 8).
D. Values area fields are shown as summarized numeric values in the PivotTable (See Figure 8).
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2. The PivotTable will change to show the fields in their respective locations, showing total sales

for each sales person by product (See Figure 9).

Region (All)

Row Labels
Arnold, Cole
Byrd, Asa
Christensen, Jill

Kelly, Icelita

Leon, Emily
Livingston, Lynette
Lucas, John
Maynard, Susan
McCullough, Scott
Norman, Rita
Owen, Robert
Vaughn, Harlon
Grand Total

Sum of No.ltems  |Column Labels
prs-rscem o nss aaseaa e |
v Bamboo Coffee Table Bamboo End Table Captain Recliner Chameleon Couch Media Armoire Grand Total

v

154 104 138 121 91 608
150 69 155 101 110 585
209 118 151 117 183 778
19 150 90 174 166 599
154 124 80 105 169 632
79 122 74 107 142 524
77 130 75 172 62 516
147 145 125 116 212 745
93 62 72 90 121 438
134 145 79 128 172 658
157 120 150 249 170 846
239 199 214 199 217 1068
1612 1488 1403 1679 1815 7997

Filtering the PivotTable

The following shows how to filter information within a PivotTable:

1. Next to a Field Header, click the dropdown arrow (See Figure 10).

Figure 9 - PivotTable Results

Region (Al

Row Labels
Arnold, Cole
Byrd, Asa

Grand Total

Sum of No.ltems Column Labels

v

154 104
150 69
304 173

~| Bamhoo Coffee Table Bamboo End Tahle Captain Recliner Chameleon Couch

138
155
293

121
101
222

Figure 10 - Dropdown Button
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2. A Dropdown menu will appear with values for the field listed below (See Figure 11).

8| SortAtoZ
El SortZto A

More Sort Options...

Label Filters »
Value Filters ’
Search ye
T
W (Select All) =
[v] Arnold, Cole
¥ Byrd, Asa

¥ Christensen, Jill
V] Kelly, Icelita

¥ Leon, Emily

[V Livingston, Lynette
¥ Lucas, John

[¥] Maynard, Susan
¥ McCullough, Scott

m

OK J[ Cancel J

Figure 11 - Filter Values

3. Click the checkboxes to select/deselect values that you want to filter for.
4. Click on OK to apply your filter.

5. Afilter icon will appear next to the dropdown arrow to indicate a filter has been applied to the
field (See Figure 12).

Region (Al v
Sum of No.ltems Column Labhels v
Row Labels Eamboo Coffee Table Bamboo End Tahle Captain Recliner Chameleon Couch
Arnold, Cole 154 104 138 121
Byrd, Asa 150 69 155 101
Grand Total 304 173 293 222

Figure 12 - Filter Applied

6. To remove the filter, click on the dropdown arrow.
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7. The dropdown menu will appear. Click on Clear Filter From to remove the filter (See Figure 13).

PivotCharts

Sort AtoZ

PN N
—

—
%)

SortZto A

vore Sort Options..,

% ClearFilter From "Salesperson”

Label Filters
Walue Filters

Search

Yy (W] (Select All)

¥ Arnold, Cole

-[¥] Byrd, Asa

-[_] Christensen, Jill
-] Kelly, Icelita
~[_]Leon, Emily

-] livingston, Lynette
~[Jlucas, John

-] Maynard, Susan
~[JMcCullough, Scott

[ o ]

=

Cancel ]

Figure 13 - Clear Filter From

Similar to PivotTables, PivotCharts can be used to quickly summarize, sort, filter, and analyze large
amounts of data, and display that data as a visual representation. After creating your PivotTable, you
can create a PivotChart using a variety of available charts (e.g. Pie, Line, Bar) that uses the same field

settings.

Creating PivotCharts
The following will show you how to create a PivotChart from an existing PivotTable:

1. Inthe Ribbon, click on the Insert tab (See Figure 14).

FILE HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEWY WIEWY DEVELOPER
v v . A%
B (o s 5 WS-k g (w (@] & (4] |0
; I ? \"}‘:" - ‘\ 2 I-\i . I @ A0 - : =
Tables Illustrations Apps  Recommended ~ PivotChart  Power Sparklines Filters Hyperlink  Text  Symbols
v v M Charts . AR v Wiew v v v v
Charts x Reports Links

Figure 14 - Insert Tab
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2. Under the Charts grouping, click on PivotChart (See Figure 15).

1?

IR Al b
Recommended

Charts @~ l-_"

Figure 15 — PivotChart

3. The Insert Chart window will appear. Select a chart from the options presented (See Figure 16).

(ineext Chart

All Charts

™ Recent ¥ :
e | 1 NEEH (BR B J0f)

E}l Column

|2 Line Stacked Column

® Pie : I

E b - 1 |' s
@ Area - | l ll! { . I| -u-.....,..
[ XY (Scatten) "‘“ I||||I| —
il Stock , W ; A 3

@ Surface

Figure 16 - Insert Chart

4. Click on OK.

5. The PivotChart will be placed into your worksheet (See Figure 17).

Region v
Sum of No.ltems

| 1200
| 1000

800
Product v

m Media Armoire
# Chameleon Couch
m Captain Recliner

600

|
s00 o
200I
0

H Bamboo End Table
m Bamboo Coffee Table

@ 2 N @ & o & @ &
> o & & ¢ & P F S
XS 0 & 23 o o S > o & X
8 & NN ) o & A S &

: © ¥ 8 N & \ S o ®
& » ™ N

o 5 B4 N &

& & o “‘& 3

|Salespersan ¥

Figure 17 - PivotChart Inserted
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6. The PivotChart Fields will appear on the right of the screen (See Figure 18).

PivotChart Fields wX

Choose fields to add to report: y ¢ e g

v| Salesperson
v| Product
v| Region
Customer
Date
Item Cost
v| No.Items
Total Cost

Drag fields between areas below:

Y FILTERS Il LEGEND (SERIES)

Region - Product ha

= AXIS (CATEG... 2. VALUES

Salesperson ¥ | || Sum of No.lte... ¥

Figure 18 - PivotChart Fields

Note: You can alter the information that is displayed the same way as with PivotTables. See Analyzing
Data with PivotTables for more information.
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Filtering the PivotChart

The following shows how to filter information within a PivotChart:

1. Next to a Field Header, click the dropdown arrow (See Figure 19).

Region ¥

Sum of Mo.Items
1200
1000 l
800 l l
600

200 I | B a8 - I -

5]
= fR LAl
0
NS ¥

g Vb’b \\\ &S@ @S\ d}& 6°° ,_;o“ bg,\ Q.S@ ‘o‘?’{\ &\OQ

A D B N « P S X
& ot RN SR A N S )

& AN @ o \)9 N \)% O QO o

4 é < S () o (\’b \0 oﬁ < é\

b d‘° Q;} A D v »

& ¢
3 <
Salesperson Ve

Product b

m Media Armoire
Chameleon Couch

m Captain Recliner

B Bamboo End Table

B Bamboo Coffee Table

Figure 19 - Dropdown Button

2. A Dropdown menu will appear with values for the field listed below (See Figure 20).

More Sort Options...

Label Filters

Value Filters

éearch

"IV (Select Al

[+ Arnold, Cole

[ Byrd, Asa

--[¥] Christensen, Jill
|V Kelly, Icelita

-] Leon, Emily

-[¥] Livingston, Lynette
[ Lucas, John

-[¥] Maynard, Susan
-[¥] McCullough, Scott

[ »

-

[ ok

][ Cancel ]

Figure 20 - Filter Values

3. Click the checkboxes to select/deselect values that you want to filter for.

Page 14 of 19



4. Click on OK to apply your filter.

5. Afilter icon will appear next to the dropdown arrow to indicate a filter has been applied to the
field (See Figure 21).

Region ¥
Sum of No.Items
700
600
500
400
300
200
100
0

Arnold, Cole

Salesperson

-

Byrd, Asa

Product X

= Media Armoire
Chameleon Couch

m Captain Recliner

B Bamboo End Table

B Bamboo Coffee Table

Figure 21 - Filter Applied

6. To remove the filter, click on the dropdown arrow.

7. The dropdown menu will appear. Click on Clear Filter From to remove the filter (See Figure 22).

—

Sort&AtoZ
SortZto &
More Sort Options...

>N N
e

1%

Clear Filter From "Salesperson”

Label Filters

Walue Filters

igearch

V] (Select Al

- Amold, Cole
-] Byrd, Asa

-] Kelly, Icelita
~[Leon, Emily

-] Lucas, John

~[_] Christensen, Jill

~[Jlivingston, Lynette

-] Maynard, Susan
~[IMcCullough, Scott
™ e -

[ o ]

=

Cancel I

Figure 22 - Clear Filter From
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Using Slicers to Filter Data

Slicers can provide greater control over your PivotTable or PivotChart when you are analyzing your
data. Slicers work similar to filtering your information, but allows you to insert tables that you can use
to quickly select values to filter/unfilter. They will show what is currently shown/not shown at a glance.
Slicers can also be adjusted to change their size and color to make them more presentable.

Inserting Slicers into your PivotTable or PivotChart
The following explains how to insert Slicers into your PivotTable:

1. Click within your PivotTable to select it.

2. Inthe Ribbon, click on the Insert tab (See Figure 23).

HOME INSERT PAGE LAYOUT FORMULAS DATA, REVIEWY WIEWY DEVELOPER

> = o i Jag atal e
=2 (] || 1?2 | e o (= (B & (4] (@

; \‘iv.‘:{ = ‘\ > I‘\i 2 (“.‘.- . - oo
Tables Illustrations Apps  Recommended ~ PivotChart Power Sparklines Filters Hypetlink Text  Symbols
v v v Charts L ARER v YWiew v v M v
Charts x Reports Links

Figure 23 - Insert Tab

3. Under the Filters grouping, click on Slicer (See Figure 24).

5|

Slicer fTimeline

Filters

Figure 24 - Slicer

4. The Insert Slicers window will appear with a list of your available fields (See Figure 25).

e
Insert Slicers i

|_|salespersan |
[]Product

[]Region

[]Customer

[ Date

[]item Cost

[INo.ltems

[]Total Cost

Figure 25 - Insert Slicers Window
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5. Click the checkboxes next to the fields you want to create slicers for.

6. Click on OK.

7. The slicers will be inserted into your spreadsheet (See Figure 26).

8. Click and drag the slicers to reposition them as necessary.

9. To apply a filter from one of the slicers, click on one of the values (See Figure 27).

Note: To select multiple values, hold down the shift key while clicking your values.

Salesperson

! Arnold, Cole ‘ =

\ Byra,: Product

\m \ Bamboo Coffee Table \
\?ellyj | Bamb( Region

\7Leon, \Ept; \ NE

| Living \E‘; | NW

‘ Lucas, lm \ SE

\ Mayn'u;-, Susar ’ SW

Figure 26 - Slicers Inserted

Salesperson

ﬁmnold, Cole \ 2

] Byrd, Asa ||

} Christensen, Jill

|
] 7 Kelly, icelita |

\ Leon, Emily

|
| Livingston, Lynette |

} Lucas, John

] Maynard, Susan

Figure 27 - Using a Slicer
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10. To remove values from your slicer, click the Clear Filter icon in the upper-right corner of the

slicer (See Figure 28).

Additional Slicer Options
When a Slicer is selected, the Slicer Tools — Option tab will be available in the Ribbon. From this tab,

: Arnold, Cole

Salesperson eyx
: s

Byrd, Asa
Christensen, lill
Kelly, Icelita

Leon, Emily
Livingston, Lynette

Lucas, John

Maynard, Susan J
v

Figure 28 - Clear Filter from Slicer

you can change the Slicer caption, style, and size of the buttons and window. To access the

Slicer Tools — Options tab:

1.

2.

Click on the Slicer.

In the Ribbon, click on the Slicer Tools — Options tab (See Figure 29).

Slicer Caption:
Product

Slicer Setti

HOME INSERT PAGE LAYOUT FORMULAS

;i

S

Report
"33 Connections

Slicer

Slicer Styles

SLICER TOOLS

DATA, REVIEWY WVIEW DEVELOPER OPTIONS

Arrange

.1 Bring Forward ~
0 Send Backward ~

515 Selection Pane

= : =
< Galdmns; [ = &l Height: |2.76"
5DHe|ght: 0.26" %
S . ooy Width: (2" S
oy Width: 1,81
Buttons Size 7 ~

Figure 29 - Slicer Tools - Options Tab

3. Additional Slicer tools will be displayed. From here you can alter the slicer captions, styles, and

button and window size (See Figure 30).

Slicer Caption: 52
Salesperson

Slicer Settings  Connections

s
r

Report

Slicer

.1 Bring Forward ~

Eﬂc Selection Pane

Slicer Styles Arrange

v 0 Send Backward ~

‘B Columns: |1
% [| Height: |0.26"
2oy Width: [1.58"

% [| Height: |2.76" 2

“rjarian

os Width: |2"

Buttons Size =

Figure 30 - Additional Slicer Tools
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Additional Help

For additional help mail us : support@99excel.com

Excel Service Desk for Faculty & Staff

e Phone: +91 96544-212-88
e Email: support@99excel.com
e \Website: www.99excel.com
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